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Before you Install

Maplnfo Professional® is a comprehensive computer mapping tool that enables
you to perform complex geographic analysis such as redistricting, accessing
your remote data, dragging and dropping map objects into your applications,
creating thematic maps that emphasize patterns in your data, and much more.

This document describes how to install Mapinfo Professional to your desktop. It
also provides more advanced topics that an IT Specialist or System Administer
would follow for installing Maplnfo Professional within an organization.

For information about how to work with Mapinfo Professional, see the Mapinfo
Professional User Guide after installing MaplInfo Professional.

Topics in this Section:

¢ Introduction ........ ... ... e e 7
¢ SystemRequirements .............. . ... i 8
+ Maplinfo Professional Database Connectivity and Support...... 9
¢+ Maplinfo Professional Web Server Support.................. 13
+ Before You Install MapInfo Professional .................... 13

¢ CitrixInstallations ............. .. it 15




Chapter 1: Before you Install
Introduction

Introduction

This document is organized in two parts. The first provides information and instructions necessary
for installing Maplnfo Professional to a user’s desktop. The second, titled Advanced Topics for
System Administrators, provides information and instructions necessary to IT Specialists or
system administrators who must install Maplinfo Professional in an organization.

Maplinfo Professional Users
To install MaplInfo Professional on your desktop:

1. Review the information in this chapter:
» System Requirements,
* Maplinfo Professional Database Connectivity and Support on page 9, and
« Before You Install Mapinfo Professional.

2. Follow the instructions in Chapter 2: Installing Maplnfo Professional.

To remove Maplinfo Professional from your desktop, see Modifying or Removing Maplnfo
Professional on page 25.

IT Specialists or System Administrators

System administrators installing MapInfo Professional should refer to the chapters in the second part
of this document, see Advanced Topics for System Administrators on page 44, which contains
information for installing a workgroup, performing a silent installation, and advanced configuration
options.
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System Requirements

Below are the guidelines for minimum and recommended system requirements. Note that hardware
requirements do vary based on your use of the product and your system. In general, a higher
processor speed, larger memory (RAM) and industry leading graphics cards provide a better user
experience and result in better responses from Maplinfo Professional. These are the minimum
system requirements for Mapinfo Professional 10.5:

Operating Systems Memory Disk Space Graphics | Monitor
Windows XP Professional SP3 256 MB RAM with a 1.5 gigabytes (GB) | 16- or 24- | 800x600
Windows Vista Ultimate SP2 400 MHz Pentium bit Color Display

processor (1 GHz
Windows 7 Ultimate Pentium processor
Windows 7 Ultimate 64-bit recommended)
Windows 2008 Server 512 MB of RAM with | 2.9 gigabytes (GB) | 16- or 24- | 800x600
Windows 2008 Server with a 400 MHz Pentium bit Color Display
processor (1 GHz
XenServer )
Pentium processor
recommended)
* Maplnfo Professional is not currently Windows Vista certified.
These are the recommended system requirements for Mapinfo Professional 10.5:
Operating Systems Memory Disk Space Graphics Monitor
Windows XP Professional SP3 256 or 512 MB Fast EIDE 2 Mid to High 2D/3D | Greater
. . . RAM with a or SCSI card with 128 MB | than
Windows Vista Ultimate SP2 400 MHz Pentium | Interface with | or better 1024x768
Windows 7 Ultimate processor (1 GHz | 2GB or better resolution
Windows 7 Ultimate 64-bit Pentium processor | i, 450 B or better
recommended)
Windows 2008 Server Same, PLUS Fast EIDE 2 Server: Same Greater
Windows 2008 Server with memory sufficient | or SCSI . Client. Choose than
to support each Interface with 1024x768
XenServer based on .
connected user 2GB or better . resolution
resolution/speed or better
Data 450 MB | requirements

Maplinfo Professional is tested on the following Microsoft Windows Desktop Operating Systems:

*  Windows XP Professional Service Pack 3 (SP3)

*  Windows 2008 Server

* Windows 2008 Server with XenServer

Maplinfo Professional 10.5
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*  Windows Vista Ultimate SP2
*  Windows 7 Ultimate
* Windows 7 Ultimate 64-bit with 32-bit compatibility mode

®

There are no special installation instructions for installing Mapinfo Professional on a 64-bit
Windows Operating System. Follow the instructions for your installation type,
,or

Dependencies and Prerequisites

The Maplnfo Professional install wizard checks for the following and prompts you if not already on
your system; you can choose to have the install wizard install these requirements, or cancel the
installation if you do not want to proceed.

» Microsoft Office Access database engine 2007 — the Access 2007 drivers (ACE)
*  Microsoft .NET Framework 3.5 SP1

Maplnfo Professional installs a file from the Microsoft Windows Presentation Foundation (WPF)
toolkit, WPFToolkit.dll file version 3.5, which is necessary for the MetaData Catalog Browser feature.

Maplinfo Professional Database Connectivity and Support

Maplnfo Professional supports the following spatial database servers:

Microsoft SQL Server 2005 with SpatialWare 4.9

Microsoft SQL Server 2008 (also called SQL Server Spatial)

Microsoft SQL Server 2008 (also called SQL Server Spatial) with SpatialWare 4.9.2
Oracle Spatial 11G, 10Gr2

PostgreSQL 8.3 with PostGIS 1.3

Further, using ODBC drivers, you can access your data from MapInfo Professional using:

Microsoft SQL Server 2005

Microsoft SQL Server 2008 Native Client
Oracle ODBC Driver 10.x

Oracle Instant Client version 11.1.0.6
PostgreSQL ANSI ODBC driver 8.x

You can also open tables of data from the following databases and make them mappable, but only
for point data:

Microsoft Access 2007

Microsoft SQL Server 2005/2008

Microsoft SQL Server 2008 XY on a spatialized database
Oracle Spatial 11G, 10Gr2

PostgreSQL 8.3 with PostGIS 1.3
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For more about working with remote database information, see Accessing Remote Data and Setting
your Database Connection Preferences in the Help System.

A Note about SQL Server 2008 Support
SQL Server 2008 (SQL Server Spatial) provides a different ODBC driver for Windows Vista.

A Windows Vista user must use the x64 and Itanium versions of sqgincli.msi, which installs the 64-bit
and 32-bit versions of SQL Server Native Client, on your 64-bit Windows operating system

To download the appropriate sglncli.msi, see:

A Note about SQL Server 2005 Support

Maplnfo Professional supports the changes in the MS SQL Server 2005 schema concept. Microsoft
has enhanced SQL Server 2005 to use schemas to organize database objects into namespaces. In
the past the schema was part of the owner/user construct, so when you deleted a user, you deleted
the objects associated with that user.

Using SQL Server 2005, objects are associated with a schema, which can be associated with many
users and each user can be associated with many schemas.

The old fully qualified name of a database object was:
Server.Database.User.Object.

The new fully qualified name of the object is:
Server.Database.Schema.Object

If you leave out the server and database name identifiers, Maplnfo Professional uses the current
server and database names. If you do not explicitly specify a schema for a user, the server assumes
any unqualified object names are in the default schema. Therefore, if you are accessing a SQL
Server 2005 database, you need to update any features/functions, tools, and test scripts accessing
the objects, including the metadata in the MAPCATALOG, to use the new fully or partially qualified
object name.

To make this version of SQL Server work, you must have this 8.5.1 (or later) version of MaplInfo
Professional. There is a work around for MapInfo Professional 8.5 and earlier versions that
accesses a server table with the form, Database.Owner.Object. Review the Maplnfo Professional
8.5 User Guide for these instructions.

Maplinfo Professional Data File Support

You can open the following file types using the File > Open capability in MaplInfo Professional:

« ACCDB - Microsoft Access 2007 or later files
¢ CSV - Comma Delimited files
- DBF - dBASE DBF files

Maplinfo Professional 10.5 10 Install Guide


http://msdn.microsoft.com/en-us/library/ms131321.aspx

Chapter 1: Before you Install
Maplinfo Professional Data File Support

MDB - Microsoft Access files

TAB — Maplnfo .TAB files

Raster image files — (*.bil, *.sid, *.gen, *.adf, *.img, *.ntf, *.ecw, *.url, * tif, *.grc, *.bmp, *.gif,
*tga, *.jpg, *.pcx, *. jp2, *.j2k, *.png, *.psd, *.wmf, *.emf, *.map)

SHP - ESRI Shapefiles

TXT — Delimited ASCII files

WKS - Lotus 1-2-3 files (*.wk1, *.wks, *.wk3, *.wk4)

WOR - Maplnfo workspace files

XLS - Microsoft Excel files

XLSX — Microsoft Excel 2007 or later files

Grid images — (*.adf, * flt, *.ixt, *.asc, *.img, *.dem, *.dt0, *.dt1, *.dt2, *.mig, *.grd)This release
does not support .XLSM and .XLSB Excel files.

@ Grid Format Direct Support: The following grid handlers support direct read of DEM-USGS

Text (.dem); GTOPO30 (.dem) and DTED levels 1, 2, 3 (.dt0, .dt1, .dt2). These grid handlers
are read-only; they cannot be used to create grid files during the Create Grid Thematic
interpolation process.

Using the Universal Translator, you can import these file format types:

*CATD.DDF - Spatial Data Transfer Standard (SDTS), such as TRO1CATD.DDF

DWG, DXF — AutoCAD
Maplnfo Professional only supports Table > Import (DXF) to release 13. This table import
functionality is superseded by the Universal Translator and Open Universal Data feature.

DGN - Microstation Design files (DGN)

E00 - ESRI Arcinfo format

**FT - Vector Product Format (VPF), such as POAREA.AFT, POLINE.LFT, POPOINT.PFT
MID, MIF — Maplnfo file formats (MIF)

SHP — ESRI Shapefile format

TAB - Maplnfo .TAB files

You can import the following file types into MaplInfo Professional using Table > Import:

DXF — The graphic/data interchange format (DXF) for AutoCAD and other CAD packages
GML - OS MasterMap format

GML, XML — Geographic Markup Language (GML) 2.1

IMG - A file format for MaplInfo Professional for DOS image files

MBI - Maplnfo Professional Boundary Interchange format (MBI)

An ASCII file for MapInfo DOS boundary files.

MIF — Maplnfo Professional Interchange Format (MIF)

Maplnfo Professional’s data interchange format (ASCII file format).

MMI - MapInfo DOS MMI

@ You can download raster handlers for NIMA formats such as ADRG, CADRG, ASRP, CIB,

USRP, and NITF formats from the Pitney Bowes Software Inc. website or get them from the
Installation DVD.
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Maplnfo Professional imports graphics and textual information from Mapinfo Professional
Interchange Format, DXF, MBI, and MMI files. MaplInfo Professional imports only graphics from
IMG.

These are the Raster image file formats Maplinfo Professional supports:

ADF — Arcinfo coverage Data File (ADF)
ASC — ASCII text file

BIL — Satellite Pour I'Observation de la Terre (SPOT) satellite images
Spot Image Formats 1.5 and 4.0: 8 Bit Gray, Format 1.5, 8 Bit Gray, Format 4.0, 24 Bit Color,
Format 1.5, 24 Bit Color, Format 4.0

BMP — Windows bitmap (BMP) Monochrome: 8 Bit Color, 24 Bit Color

filename.* — Compressed ARC Digitized Raster Graphic (CADRG) format
filename.* — Controlled Image Base (CIB) format

ECW - Enhanced Compression Wavlet (ECW) 2.0 format handler by ER Mapper
EMF — Enhanced Metafile Format

FLT — Image Filter (FLT)

GEN - ARC Digitized Raster Graphic (ADRG) format

GEN - ARC Standard Raster Product to 1.2 (ASRP) 1.2 format

GIF — Graphics Interchange Format (GIF)

GIF — Graphics Interchange Format (GIF89a) non-interlaced only Monochrome: 8 Bit Color
GRC — Maplnfo Vertical Mapper

GRD - Maplnfo Vertical Mapper
Maplnfo Professional treats GRD files as either a grid or raster image. If the associated .TAB file
contains a RasterStyle 6 entry, then MaplInfo Professional treats the file as a grid.

JFIF — JPEG File Interchange Format (JFIF)
8 Bit Gray, 24 Bit Color, No Subsampling, 24 Bit Color, YUV422 Subsampling, 24 Bit Color,
YUV411 Subsampling

JP2 — Joint Photographic Experts Group (JPEG) 2000 format
Maplnfo Professional supports creating JPEG 2000 files using Save Window As and viewing
JPEG 2000 files using the LeadTools raster handler.

JPG — Joint Photographic Experts Group (JPG)

JPEG - Joint Photographic Experts Group (JPEG)
8 Bit Gray, 24 Bit Color, No Subsampling, 24 Bit Color, YUV422 Subsampling, 24 Bit Color,
YUV411 Subsampling

NTF — National Imagery Transmission Format (NITF) version 2.x format
PCX — ZSoft Paintbrush

PCX — Format Version 5 (Paintbrush Version 3.0)
Monochrome, 8 Bit Gray, 8 Bit Color, 24 Bit Color

PNG - Portable Network Graphics (PNG) format
PSD — Photoshop 3.0

SID — MrSID format
The MrSID raster handler allows you to open and display raster images compressed in the
MrSID format

TIF — Geographic Tagged Image File Format (GeoTIFF)
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TIF — Tagged Image File Format (TIFF)

TIFF Revision 5.0, Monochrome (Class B), Uncompressed, Monochrome (Class B), PackBits
Compression, 8 Bit Gray (Class G), Uncompressed, 8 Bit Color (Class P), Uncompressed, 24 Bit
Color (Class R), Uncompressed

TIF — Tagged Image File Format (TIFF) CMYK

TIF — Tagged Information File Format (TIFF) CCITT Group 4
TIF — Tagged Information File Format (TIFF) LZW

TXT — Text

TGA - Targa
TGA Truevision File Format Specification 2.0. 8 Bit Gray, 8 Bit Color, 24 Bit Color

WMF — Windows Metafile Format (WMF)
The raster handler will load a rasterized version of the WMF file.

File Limitations for MapInfo Professional Supported Formats

Keep the following notes in mind when working with these MaplInfo formats:

* Maplnfo Professional only supports the DXF file import to release 13. This has been
superseded by the Universal Translator and Open Universal Data feature.

* The Open Universal Data feature supports all DXF formats up to the current AutoCAD
release. While it is our company’s intention to keep pace with the new releases of FME, if you
extend the application to import AutoCAD DXF files using a newer version of FME before we
have upgraded our product, errors may occur

* You can have maximum 500 files open at a time in MaplInfo Professional if you remove the
HKEY_LOCAL_MACHINE\SOFTWARE\MapInfo\MapInfo\Common Max Files registry key

* You can have up to 125 files open at a time for editing in MapInfo Professional.

Maplinfo Professional Web Server Support

Maplnfo Professional supports the Web Feature Server (WFS) 1.0 and GML 2.0, and supports the
Web Map Server (WMS) 1.3. Maplinfo Professional also supports the mapping tile servers:

Microsoft Bing tile server
Maplnfo Developer tile server
MapXtreme.NET tile server
OpensStreetMap tile server

Before You Install Mapinfo Professional

Before installing MapInfo Professional, record your serial number and access code in an easy-to-
remember place. You need a valid serial number and access code to complete an installation or an
upgrade. Also, complete the postage-paid registration card and return it to Pitney Bowes Software
Inc., or register online by accessing the Contact Info option on the DVD Browser.
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If the MaplInfo Professional installer detects a current version of the product, or detects that the
product had been previously installed, then the installer copies the MAPINFOW.WOR,
STARTUP.WOR and MAPINFOW.PRF from the operating system's system directory to <user
profile root>\Application Data\MaplInfo\MapInfo.

Application data (appdata) files are the non-executable data files that MapInfo Professional uses
during operation.

Navigating the Mapinfo Professional DVD Browser
The initial screen of the Maplnfo Professional DVD Browser includes these options:

* Install Products
From this option you can install Maplnfo Professional (including DBMS support and
translators), free data, and Install Utilities, including: ECW Compressor and GPS.

*  What’s New
Displays a list and description of new and enhanced features.

* Online Reference
Maplnfo Professional provides links to online reference documents, such as the Mapinfo
Professional Install Guide (this document) and Mapinfo Professional User Guide, as well as
the Adobe Acrobat Reader. These documents are copied into the Documentation subfolder
of your installation directory during the installation process.

*  Mapinfo Tutorial
From this option you can access the Maplinfo Professional Tutorial from the Pitney Bowes
Software Inc. web site to learn more about the basic features of the product.

* Other Products
Displays information about MapBasic, Mapinfo Vertical Mapper, and other products from our
website.

» Contact Information
Where ever you are, Pitney Bowes Software Inc. is there to help you. Contact us at any of
these locations or visit us on the world wide web at !

* Register Online
To register your product, simply click this entry and the wizard walks you through the
registration process quickly.

* Browse DVD
From this option you can review the contents of the DVD. There are additional utilities that
may be useful to you that are only available when you browse.

«  Exit
From this option you can close the DVD Browser application.

Maplinfo Professional 10.5 14 Install Guide
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Citrix Installations

Typically, a Citrix installation is performed by an IT Specialist or a system administrator, but this is
not always the case.

There are no special installation instructions for installing MaplInfo Professional in a Citrix
environment. In addition to the product serial number and access code (supplied on the Product
Activation Information Card in the product box), you will also need the Maplnfo License Server
machine name and port number to activate Maplnfo Professional with. Your system administrator
will supply this information.

Information for IT Specialist or System Administrators
In addition to MaplInfo Professional, you will also have purchased:

* A Maplnfo License Server Utility to activate MapInfo Professional with.
Citrix installations require a Maplnfo License Server Utility to activate MapInfo Professional. For
instructions on how to install and set up a Maplinfo License Server for your organization, see the
User Guide that is provided with the Pitney Bowes Software Inc. License Server.

* One or more concurrent non-borrowing serial licenses for Maplnfo Professional, depending on
the number of Maplnfo License Servers you require and the number of users serviced.
For instructions on how to activate a MapInfo Professional installation, see

in
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This chapter provides instructions for installing Maplinfo Professional on your
desktop. In addition, there are instructions for fixing problems that come up as
part of the installation process and for removing MaplInfo Professional from your
desktop.
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Installing MapInfo Professional

CAUTION: We strongly recommend that you exit from all Windows programs before
beginning the installation process. If you are upgrading from an earlier version
of Maplnfo Professional, we recommend that you uninstall before upgrading.

You must have Administrator rights to run the Installer.

If your Windows Start menu does not have a Maplinfo program folder, the installation process
creates this folder. If your Windows Start menu already has a Maplinfo program folder, this process
creates a new Maplinfo icon within that folder.

Maplnfo Professional provides its application data files to each user. Called a Per-User install, this
functionality runs the first time you run Maplnfo Professional or Maplinfo Professional client on a
machine, and each time the Mapinfo Professional Installer is run thereafter. The application data
files include, among others, the Pen Styles file, Custom Symbols files, Graph Support files, and
Thematic Legend templates. These files allow different users to have custom settings.

@ The Installer requires that your TEMP variable be set to a valid directory.

To install MaplInfo Professional:
1. On the Launcher menu, click Install Products from the Maplinfo Professional DVD Browser.

2. Click Mapinfo Professional Installer.
Vista & Windows 7 users: You may see a prompt for permission to continue. Click Allow or
Yes to proceed (if you do not respond and the message times-out, the install is unsuccessful).
3. If the following is not already installed on your system, then a prompt displays to install it:
» Microsoft Office Access database engine

¢ Microsoft .NET Framework
Click Install.

If you see a message that MaplInfo Professional requires a reboot, click Yes. You must reboot to
continue with the installation.

4. Click Next to continue the process and display the License Information screen and accept the
terms of the agreement.

5. Click Next to continue. The Customer Information screen displays.
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5 Maplnfo Professional 10.5 - InstallShield Wizard

Customer Information ..

Flease enter your information,

User Mare:

|User

Qrganization:

|C0mpany Marne

[ ¢heck here if you are installing an Evaluation copy

Serial Mumber:

Access Code:

[ < Back ” ek = ] [ Cancel ]

6. Type your name, organization name, serial number, and access code in the corresponding
fields. The serial number and access code are listed on the Product Activation Information Card
in the product box and are used to activate your product. Click Next to continue.

@ Do not select the check box. Doing so installs an evaluation copy of Maplinfo
Professional. If you select to install an evaluation copy, then you may activate your copy
after installation using with your serial number and activation code.

7. Do one of the following:
» If your organization purchased node-locked licenses, the third character of your serial
number is "N". Skip this step and go to step 8.

» If your organization purchased concurrent licenses, the third character of your serial number
is "8". In those cases, the License Server Name and Port screen displays on the screen.
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i% Maplnfo Professional 10.5 - License Server, Name and Port g|

Enter the name and port number of your license server below -.

A

‘four serial number indicates you have purchased MapInfo Professional 10,5 to be used
with a license server, Enter the network name and port number of your organization's
license server here, I you do not have this information, click Mext ko skip this step,

License Server Mame

License Server Pork Number

[ < Back ” ek = ] [ Cancel ]

If you know the license server name and port number, enter them here. If you do not, you can
continue with the installation without filling in the license server name and port number. You
will have another opportunity to supply this information when you start MapInfo Professional.
Click Next.

G) For more information about node-locked and concurrent licenses, see

8. Review the following installation types and determine which instructions are appropriate. Click
one of the following and click Next to continue:

» Typical Workstation Installation. Click this option if you will be using MaplInfo Professional
as a desktop application including remote database access and connectivity. See

to continue these instructions.

» Custom Workstation Installation. Click this option to restrict the components that are
installed by the installation program. For example, you can prevent the installer from adding
the help system and tools. See to continue
these instructions.

G) There are no special installation instructions for installing MapInfo Professional in a Citrix
environment. Citrix users follow the instructions to
install MaplInfo Professional.

Typical Workstation Installation

Choose this option to install MapInfo Professional program files, Online Help, Tools, Universal
Translator, and Crystal Reports.

CAUTION: Make sure you have completed the directions in
before beginning these instructions.
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To continue installing Mapinfo Professional on a workstation:

1. In the Setup Type screen, click Typical Workstation Installation; the Destination Folder screen
displays. If you have an earlier version (or versions) of MaplInfo Professional installed and you do
not want to overwrite that version, create a new directory name in the next step.

2. Do one of the following:
» Click Next to accept the destination folder indicated

» Click Change to create a new path in the Change Current Destination Folder screen. Type
the new path in the Folder name field and click OK to continue. Click Next to continue.

The Ready to Install the Program screen displays. Review your selections to ensure that the
path is correct before moving on. Click Back to make changes.

3. Click Install to begin. A progress bar indicates the status of the process.

@ If you are using ODBC or Oracle Spatial for database connectivity, we install ODBC
Connectivity and Oracle Spatial support by default to simplify the connectivity process.

4. Atthe end of the installation, the prompt: “Would you like to check our web site for any current
updates to our product?” displays. If you have an Internet connection, click Yes to access the
Pitney Bowes Software Inc. Corporation web site containing information about product updates.

5. When the Complete screen displays, choose Finish to return to the Install Products screen.

Continue to orto

Custom Workstation Installation

Choose this installation type to select components and drivers within the Maplnfo Professional
installation program. This is particularly useful if you want to save disk space by not installing the
Help System, the documentation, or the Maplnfo Professional tools.

CAUTION: Make sure you have completed the directions in
before beginning these instructions.

To continue installing using the custom workstation instructions:

1. In the Setup Type screen, click Custom Workstation Installation; the Custom Setup screen
displays. A feature description and the space required for the feature and its sub-features
displays in the Feature Description area.

2. In the Custom Setup screen you decide what components are to be installed and the directory
you want them to install to. Click the feature icon to select the feature for installation.
The options for a Custom Setup include:
* Maplinfo Program Files (you must install these files to run Maplnfo Professional)
* Documentation (installs user guide documents in PDF format)
* Tools (installs Mapinfo Utilities and Crystal Reports)

3. To select a feature, click the Down Arrow beside it; a menu displays.

Maplinfo Professional 10.5 20 Install Guide



Chapter 2: Installing MapInfo Professional
Installing Maplinfo Professional

= This feature will be installed on local hard drive.

=28 This feature, and all subfeatures, will be installed on local hard drive,

B This Feature wil be installed to run From netwark,

B This feature, and all subfeatures, will be installed to run from the netwark,

: = This feature will be installed when required.

¥ This feature will not be available.

4. For each feature you want to install, select one of the following:
» This feature will be installed on local hard drive.
» This feature, and all subfeatures, will be installed on local hard drive
» This feature will not be available

@ For some features, there are additional options pertaining to the use of the feature from
the network. Choose the option that describes your systems implementation of this
feature.

When you select the first or second options in the bullets described above, the feature installs on
your local hard drive in the default folder. This path displays in the Install To: entry below the
Custom Setup list pane. To specify another path, select Change button. When you do the
Current Destination folder screen displays allowing you to choose a new path.

To see if you have enough space on your hard drive or other mapped resources, click the Space
button. The Disk Space Requirement screen displays the disk size, the amount of available
space, and the amount of space the selected install would take.

@ To avoid installing a subfeature, select This feature will not be available.

5. After you select all the custom options click Next to display the Ready to Install the Program
screen.

6. Click the Install button to begin the installation of MapInfo Professional with the features you
selected. The Installing MaplInfo Professional screen displays with a progress bar indicating the
status.

7. Atthe end of the installation, the prompt: “Would you like to check our web site for any current
updates to our product?” displays. If you have an Internet connection, click Yes to access the
Pitney Bowes Software Inc. Corporation web site containing information about product updates.

8. When the Complete screen displays, choose Finish to return to the Install Products screen.

Continue to or to
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Installing Data

To help you get started, Pitney Bowes Software Inc. provides you with some United States-based
and world-wide maps you can use as a background to your data. Use these instructions to install this
free data.

To install the free data provided with MaplInfo Professional:

1.
2,

10.

From the Maplinfo Professional DVD, choose Install Products from the DVD Browser.

Choose Install Introductory Data and Industry Samples.

Vista & Windows 7 users: You may see a prompt for permission to continue. Click Allow or
Yes to proceed (if you do not respond and the message times-out, the install is unsuccessful).

The Welcome screen displays.
Click Next to continue.

The Software License Information screen displays.
Click Yes to accept the terms of the agreement and to continue the installation process.

The Select Components screen displays.

Select the product for which you will be installing the data and click Next to continue:
* Maplnfo Professional

* Maplinfo Run Time

The Choose Destination Location screen displays.

Specify the directory where the data will be installed. Use the Browse button to select a directory
if necessary or accept the default directory. Click Next to continue.

The Setup Type screen displays.
Choose one of these options:
« Custom Install to choose which datasets to install, and then click Next.

The Select Components screen displays. Select the check box beside each dataset you want
to install. The size of each dataset displays, as well as space required and space available.
To see the subcomponents of the data you selected, click Change.

* Typical Install to Install all datasets, and then click Next.
If you chose Maplnfo Professional in or chose a Custom install in , then a question

prompt displays. If you want to create an icon for each data set you choose, then click Yes to the
“Would you like setup to display workspace Icons” prompt.

If you chose to set up Workspace icons, then the Select Program Folder screen displays. Select
the program folder where the icons will be created. Choose Next.

The Start Copying Files screen displays.

Review the selections you have chosen and click Back to return to any screen to change your
selections. When you are ready to begin the installation, click Next.

The Setup Complete screen displays.
Click Finish.

Continue to orto
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Getting More Data

To learn more about our data products, choose Install Products and Obtain More Data from the
Maplnfo Professional DVD browser, or after installing Maplnfo Professional, click Mapinfo Data
Products on the Web in the Help Menu. If you have a Browser installed, you are automatically
connected to Pitney Bowes Business Insight web site, where we provide detailed information about
our World Wide Data Products. We have over 350 data products to choose from—products that
provide both reliable and current information.

Installing Related Programs and Resources
This section contains the instructions for installing the ECW Compressor, the Blue Marble GPS, and
the documentation associated with MaplInfo Professional.

The first time you start Maplnfo Professional you must activate your product license. After installing
related programs and resources, continue to

Installing the ECW Compressor

The ECW raster handler allows you to open and display raster images compressed in the ECW
format. We recommend that you exit all Windows programs before installing.

1. Choose Install Products from the Maplnfo Professional DVD Browser.
2. Choose Additional Utilities.

3. Choose ECW Compressor.

Vista & Windows 7 users: You may see a prompt for permission to continue. Click Allow or
Yes to proceed (if you do not respond and the message times-out, the install is unsuccessful).

4. The Welcome screen displays.Choose Next to continue the installation process.

5. The Software License screen displays. Choose Yes to accept the terms of the agreement and to
continue the installation process.

6. The Choose Destination Location screen displays. Specify the directory where ECW
Compressor will be installed.

7. The Select Program Folder screen displays. Select a folder. Choose Next to continue.

8. The Setup Complete screen displays: choose to display the ReadMe file and/or create a shortcut
on your desktop. Choose Finish.

Installing Global Positioning Software (GPS)
To install Global Positioning Software from Blue Marble:
1. Choose Install Products from the MaplInfo Professional DVD Browser.

2. Choose Additional Utilities.
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Choose Install GPS Support.

Vista & Windows 7 users: You may see a prompt for permission to continue. Click Allow or
Yes to proceed (if you do not respond and the message times-out, the install is unsuccessful).

A prompt displays to exit all applications before installing. Choose OK.
The Maplnfo Special Edition screen displays. Choose OK.

The Select Destination Location screen displays. Specify the directory where GPS will be
installed.

The Software License screen displays. Choose YES to accept the terms of the agreement and to
continue the installation process.

The Add to the Start Menu screen displays: click Yes to add a shortcut to the Start menu.
The ReadMe displays; choose OK to exit the ReadMe.

Installing the Online References

Maplnfo Professional installs documentation, such as the following, to the Documentation subfolder
of your installation directory:

Maplnfo Professional Licensing and Activation
Maplnfo Professional Install Guide

Maplnfo Professional User Guide

Maplnfo Professional Printing Guide

Maplnfo License Server Utility User Guide

@ If you have any questions about the use of the Acrobat Reader, contact Adobe support at

Troubleshooting your Installation

The Installer must be run from a drive with a letter such as G: and not from an explicit UNC path. For
example, you might have the Maplinfo Professional DVD in your computer as USERSPC. Other
users may share this device as USERSPC; however, it would not contain a drive letter. The Maplnfo
Professional Installation program requires a drive letter.

To remedy this situation, map your network drive to a specific drive letter:

1.

In Windows Explorer, right-click the shared directory or DVD drive that contains the Mapinfo
Professional SETUP.EXE and select Map Network Drive.

Choose a drive letter to map.

Run the Installation Program again from the newly mapped drive letter.

Vista & Windows 7 users: You may see a prompt for permission to continue. Click Allow or
Yes to proceed (if you do not respond and the message times-out, the install is unsuccessful).
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Modifying or Removing Mapinfo Professional

Use the Program Maintenance feature of the DVD Browser to modify, repair, or remove Maplnfo
Professional.

@ To set Maplinfo Professional preferences, see Setting Mapinfo Professional Preferences in
the Help System.

To access Program Maintenance:
1. Choose Install Products from the Maplnfo Professional DVD Browser.

2. Choose Mapinfo Professional.
Vista & Windows 7 users: You may see a prompt for permission to continue. Click Allow or
Yes to proceed (if you do not respond and the message times-out, the install is unsuccessful).
3. The Welcome screen displays. Choose Next. The Program Maintenance screen displays.

4. Choose modify, repair, or remove Maplnfo Professional based on your needs.

» Click Modify to display the Custom Setup screen.
» Click Repair to repair installation errors in the program.

» Click Remove to remove an existing copy of Maplnfo Professional from your system. The
installer displays the Remove the Program dialog box. Click Remove to uninstall the
product’s programs from your system.

You can also access the Program Maintenance screen from the Start menu by clicking Control
Panel and then Add/Remove Programs and finally Mapinfo Professional.

For information on node-locked license transfer options at uninstall, see

Removing Maplinfo Professional from your System using Control Panel

Remove Maplnfo Professional by accessing the DVD Browser, Program Maintenance screen, or by
choosing the Add/Remove Programs option in the Control Panel in Windows.

Removing Maplinfo Professional from your System using the DVD
Browser

To uninstall MaplInfo Professional:
1. Choose Install Products from the DVD Browser.

2. Choose Maplinfo Professional.

Vista & Windows 7 users: You may see a prompt for permission to continue. Click Allow or
Yes to proceed (if you do not respond and the message times-out, the install is unsuccessful).

3. The Welcome screen displays. Choose Next.

4. The Program Maintenance Screen displays. Choose Remove.
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Starting and Activating
Maplinfo Professional

The first time you start MapInfo Professional you are asked to activate your
product using the serial number and access code you supplied during the
installation. This section describes the activation process for the type of license
your organization purchased.

To start MapInfo Professional, do one of the following:

» Double-click the Mapinfo Professional icon on your desktop.

* From the Start menu, select Mapinfo Professional 10.5 from the
Selected Program folder.

Topics in this Section:

¢+ Determine the Type of Licenseyouhave.................... 27
¢ Node-Locked Licenses ............cciiiiiiiiiiinnnnnnnnns 27
¢ ConcurrentLicenses .........c..iiiiiiiiirirnnnnnnnreenns 37

+ Distributable Licenses. . ......... .ttt it 40
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Determine the Type of License you have

The serial number and access code that you enter during the installation indicates to MaplInfo
Professional what type of license you have. Depending on the license type, Mapinfo Professional
will guide you through activating the product (if your organization purchased node-locked licenses)
or connecting to a license server (if your organization purchased concurrent or distributable
licenses).

To determine what type of license you have:

» If the third character of your serial number is "N", your organization purchased node-locked
licenses. For activation instructions, see .

» If the third character of your serial number is "S", your organization purchased concurrent
licenses. For activation instructions, see .

» If you have limited access to email, or have installed MaplInfo Professional in a Citrix
environment, then your organization purchased concurrent non-borrowing serial licenses. Your
system administrator will provide you with a license server machine name and port number. For
activation instructions, see

Node-Locked Licenses

Node-locked licenses enable you to run Mapinfo Professional on a specific computer. If you
purchased node-locked licenses, your installation of MapInfo Professional must be activated before
you can use it. Activation is the process of acquiring a license from Maplnfo. This section explains
the activation options available for node-locked licenses.

Product Activation

Maplnfo uses the serial number and access code you supplied during the installation to activate the
product. If you need to refer to these numbers again, the serial number and access code are located
on the product box and on the Product Activation Information Card.

To activate Maplinfo Professional:

1. Install Mapinfo Professional, if you haven't already, and start the product. When you start
Maplnfo Professional for the first time after installation, the Activation Wizard launches. The
Maplnfo Professional Activation dialog box displays.
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Maplnfo Professional Activation

Activation is the process of acquiing a license from Fitney Bowes Business Inzight. ‘We
encourage you to activate now. |f you prefer to wait, the courtesy period will allow you to use
Maplnfo Professional for 30 days before activation iz required.

® Activate Now

Thiz will activate Maplnfo Professional on this computer. ou must have an
internet connection or a way to email a file to complete activation.

O Activate Later
[Courtesy period expires in 30 days)

Thiz will start Maplnfo Professional without activating it. Y'ou may activate at
any time during [or after] the courtesy period.

2. Select when you want to activate MaplInfo Professional. Select one of the following:
» Activate Now-Select this option to start activation now.

» Activate Later—Select this options to start a 30-day courtesy period in which you can use
Maplnfo Professional without activating the product.

3. Click Next.

If you selected Activate Now, go to

If you selected Activate Later, the Activation Wizard closes and the courtesy period begins. The
courtesy period enables you to use Mapinfo Professional immediately and active the product at
a time that is convenient for you. Each subsequent time you start MapInfo Professional, a dialog
box displays informing you of the time remaining in the courtesy period and giving you the
opportunity to activate the product.

You must activate Maplnfo Professional sometime during the courtesy period to avoid
interrupting your work. When the courtesy period ends, you will not be able to use Maplinfo
Professional until you activate it.

4. If you selected Activate Now, the Select Activation Method dialog box displays on the screen:
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Maplnfo Professional Activation

Select Activation Method

Select the appropriate activation method, Automatic Activation is the quickest and easiest
method, but it does require an Internet connection,

(® Automatic Activation [recommended)

Select this option if you have an Internet connection on this computer,
Automatic activation takes just a Few moments.,

) Email Activation
Select this option if you do not have an Internet connection on this
computer, This activation wizard will create a file which you must email ko
Pitney Bowes Business Insight.

[ < Back ] [ ek

5. Select one of the following activation methods:

+ Automatic Activation— Select this option if you have an Internet connection. The Activation
Wizard will make a one-time connection with a Maplnfo server. Using the serial number and
access code you provided during the installation, the Activation Wizard will retrieve one of
the licenses your organization purchased and associate it with your computer.

+ Email Activation— Select this option if you do not have an Internet connection. The
Activation Wizard will guide you through the creation of an Activation Request file that you
must then email to Maplinfo.

6. Click Next.

If you selected Email Activation, go to

If you selected Automatic Activation, the Activation Wizard takes a few moments to transfer
the activation credentials to MapInfo and perform the activation. A Mapinfo Activation message
displays on the screen to tell you that the activation was successful.

Click OK. The Activation Wizard closes, and Maplnfo Professional is ready to use. You are
finished.

7. If you selected Email Activation, the Verify Activation Credentials dialog box displays on the
screen:
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Maplnfo Professional Activation

Verify Activation Credentials

A Serial Mumber and Access Code are used to activate your copy of MapInfo Professional, IF
the Serial Number and Access Code shown below are correct, click Mext to proceed with
activation. If they are not correct, click Edit to change them before proceeding.

Activation Credentials
Serial Mumber:

Access Code:

MOTE: Your Serial Mumber and Access Code are printed on the MapInfo
Professional box as well as on a card inside the box, I you do not have
these materials, contact Customer Service, Contact information is available
at:

wiw, mapinfo, comfcustomer service

Double-check that your serial number and access code are correct. Click Edit if you need to
make any corrections.

8. Click Next. The Specify location to save Activation Request file dialog box displays on the

screen:
Maplnfo Professional Activation

Specify location to save Activation Request file

A file will be created that contains your activation information, Please use the Browse button
below to specify where you want this file saved.

Browse. ..

Select a folder in which to save the Activation Request file. Click the Browse button to navigate
to the desired location. Click OK. The path and filename of the Activation Request file appear in
the box. The Activation Request contains your serial number and access code, plus information
that identifies the computer you are activating on.

9. Click Next. The Save this important Information dialog box displays on the screen.
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Maplnfo Professional Activation

Save this important information

‘fou must email the Activation Request file to Customer Service, The location of the file and the
email address to send it to are shown below, Copy this information down so vou will have it
when you are ready to send the email,

Activation Request file:
CiATemp\DOCUMENTATION request, xml

Email address:

activation@mapinfo.com

MOTE: After wou email the file bo Customer Service, you will receive an email
response with instructions to complete the activation. You should receive the
response within one business day,

‘fou may use MapInfo Professional for another 30 days during the courtesy
period,

This dialog box provides the information to send your Activation Request file to Maplinfo. The full
path and filename of the Activation Request file is displayed in the Activation Request File box.
The email address to send the file, activation@mapinfo.com, is displayed in the Email address
box.

Take a few moments to write down the location of the Activation Request file and email address
to send the Activation Request file.

CAUTION: Please do not edit the Activation Request file in any way. If you do, MapInfo may
not be able to process it and your activation will be delayed.

10. Click OK. The Activation Wizard closes and the courtesy period automatically starts.

11. Email your Activation Request to Maplnfo at this address:
activation@mapinfo.com

You can finish email activation when you receive an Activation Response file from MaplInfo. You
should receive the Activation Response file within one business day.

Finishing Email Activation

When you receive the Activation Response file from Maplnfo, you are ready to finish activating
Maplnfo Professional.

To finish email activation:

1. Copy the Activation Response file you received from Maplinfo to an accessible folder on your
computer and make note of the location.

2. Open Maplnfo Professional. If Maplnfo Professional is already open, exit and restart the
program. A dialog box displays asking you if you want to finish activating MaplInfo Professional.

3. Click Yes. The Process Email Activation Response dialog box displays on the screen.
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4. Click Browse to navigate to the location of the Activation Response file. Click Open in the
Locate Response file dialog box when you have located the file.

5. The path and filename of the Activation Response file appear in the box.

Process Email Activation Response

To continue activation, you must have received an email containing a document. From Pitnesy
Bowes Business Insight, Please enter the location and name of the file here, and press Mext ko
lnad the response,

Activation document:

CoATemp\DOCUMENTATION response. il
m

6. Click Next.

7. A Maplnfo Activation message displays on the screen to tell you that the activation was
successful. Click OK. The Maplinfo Professional Activation Wizard closes, and Maplnfo
Professional is activated and ready to use. You are finished.

CD Once you have seen the confirmation message stating that your product has been activated,
you can delete the email response file from your system.

To check the status of your activation, choose Help > About and review the contents of this dialog
box.

Using Maplinfo Professional While You Wait

While you are waiting for MaplInfo to send you the Activation Response file, you can continue to use
Maplnfo Professional under the courtesy period. To ensure uninterrupted use of Mapinfo
Professional, we encourage you to activate before the courtesy period expires.

Each time you open Maplinfo Professional subsequent to initiating email activation, a dialog box
displays asking if you want to finish activating MapInfo Professional. When you receive the
Activation Response file from MaplInfo you are ready to finish activation.
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Maplnfo Professional Activation

Are you ready to finish activating Mapinfo Professional?

‘fou have already started the activation process by creating an Activation Request file at the
location shown below.

CiATemp\DOCUMENTATION request, xml

To complete the activation process you must send that file to
activation@mapinfo.com and receive an activation response file, Have you
received an activation response file from PEBI?

‘es ] [ Mo

To continue using Mapinfo Professional under the courtesy period:
1. Click No in the dialog box.

2. Adialog box displays on the screen that provides information about the courtesy period and asks
you how you would like to proceed.

Maplnfo Professional Activation

*f'ou may continue to uge Maplnfo Professional for the 30 dayps left in the courtesy period. Start
activation over only if you received a response from PEBI indicating that zomething waz wrong
with the activation request you submitted, or if you lost the activation request file.

& Use Maplnfo Professional
p
[Courtesy period expires in 30 days)

| want to uze Maplnfo Profeszional now:; | will activate later.

) Start Activation Over
Select this option only if a previous attempt at activation failed.
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Select one of the following:

» Use Mapinfo Professional-Select this option if you have not received an Activation
Response file yet and you want to use Maplnfo Professional under the courtesy period.

» Start Activation Over—Select this option if previous activation attempts have failed.

If you selected Use Maplinfo Professional, click Finish. The Activation Wizard closes and
Maplnfo Professional is ready to use under the courtesy period. You can finish the activation at a
later time.

If an earlier attempt to activate Mapinfo Professional failed, and you selected Start Activation
Over, click Next. The Activation Wizard restarts, giving you the opportunity to try the activation
again.

Transferring a Node-Locked License

Node-locked licenses are associated with a particular computer. To use Maplnfo Professional on a
computer other than the one on which you have it activated, and without consuming another license,
you can transfer your license from one computer to another. For example, you received a new
computer at work and you want to run Maplnfo Professional on the new computer instead of on the
old one.

@ Your organization is limited to either 10 license transfers per year or two times the number of
licenses you have purchased per year, whichever number is greater. For example, an
organization with 50 node-locked licenses of MapInfo Professional is permitted 100 transfers
per year. This lets you upgrade the entire set of user computers and provides for license
transfers, such as when employees change roles.

Transferring Your License to another Computer
To transfer a node-locked license:
1. Open Maplnfo Professional.

2. Choose Help > Licensing > Transfer license. The MaplInfo Professional License Transfer
dialog box displays on the screen.

3. Click Yes. The Select Transfer Method dialog box displays on the screen.
Select one of the following transfer methods:

» Automatic Transfer—Select this option if you have an Internet connection. Your license will
be automatically transferred to Maplnfo. You can retrieve the license by activating MapInfo
Professional on another computer.

» Email Transfer—Select this option if you do not have an Internet connection. You will be
guided through the creation of a Transfer Request file, which you must then email to
Maplnfo.

4. If you selected Email Transfer, go to

If you selected Automatic Transfer, the License Transfer Wizard takes a few moments to
transfer the license to Maplinfo. When this process is finished, a message displays on the screen
informing you that the transfer was successful.
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5. Click OK. Maplnfo Professional closes and can no longer be run from this computer. The license
is now available for you to activate Mapinfo Professional on another computer.

6. If you selected Email Transfer, the Save Transfer Request File dialog box displays on the

screen.

Maplnfo Professional Activation

Specify location to save Activation Request file

A file will be created that contains your activation information, Please use the Browse button

below to specify where you want this file saved.

Select a folder in which to save the Transfer Request file. Click the Browse button to navigate to
the desired location. Click OK.

7. Click Next. The Save this important information dialog box displays on the screen.
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Maplnfo Professional Activation

Save this important information

‘fou must email the Activation Request file to Customer Service, The location of the file and the
email address to send it to are shown below, Copy this information down so vou will have it
when you are ready to send the email,

Activation Request file:
CiATemp\DOCUMENTATION request, xml

Email address:

activation@mapinfo.com

MOTE: After wou email the file bo Customer Service, you will receive an email
response with instructions to complete the activation. You should receive the
response within one business day,

‘fou may use MapInfo Professional for another 30 days during the courtesy
period,

This dialog box provides the information to send your Transfer Request file to Mapinfo
Customer Service.

The full path and filename of the Transfer Request file is displayed in the Transfer Request File
box. The email address to send the file, activation@mapinfo.com, is displayed in the Email
address box.

Take a few moments to write down the location of the Transfer Request file and email address to
send the Transfer Request file.

CAUTION: Please do not edit the Activation Request file in any way. If you do, Mapinfo may
not be able to process it and your activation will be delayed.

8. Click OK. Maplnfo Professional closes and can no longer be run on this computer unless you
activate it again.

9. Email the Transfer Request file to MaplInfo at the following address:
activation@mapinfo.com

10. MapInfo Customer Service will send you an email reply confirming that the transfer was
successful. You should receive this confirmation within one business day.

The license is now available for you to activate Maplnfo Professional on another computer.

Uninstall Transfer Options

If you have a node-locked license and you uninstall MapInfo Professional, you have the option of
transferring the license to Maplnfo.

If you intend to install MaplInfo Professional on another computer, transfer the license to Maplinfo so
that the license is available. When you install MapInfo Professional on the desired computer, you will
be prompted to activate the product.

If you intend to reinstall MapInfo Professional on the same computer, do not transfer the license.
When you reinstall, you can reuse the same license without activating.
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When you begin uninstalling MaplInfo Professional, the Transfer License Now? dialog box displays
on the screen:

Do one of the following:

» Click Yes to transfer the license to Maplnfo. The License Transfer Wizard will start and guide
you through the transfer process. See

» Click No to keep the license on this computer. The uninstall operation continues. When you
reinstall Maplnfo Professional, you can reuse the license without activating.

Concurrent Licenses

Concurrent licenses enable you to install MapInfo Professional on any number of computers. A
license server, installed and maintained by your organization, limits the number of computers that
can run Maplnfo Professional at any given time to the number of concurrent licenses purchased by
your organization.

In the concurrent licensing scheme, you must connect to a license server on your network to check
out a license before you can run Mapinfo Professional. Checking out a license is the process of
obtaining a license from the license server. You will need to supply the license server machine name
and port number to connect to the license server. You can do this either during installation or the first
time you run Maplnfo Professional. After you have established a license server connection, the
check out occurs automatically.

A license server administrator from your organization installs and maintains the license server. The
license server administrator must also perform the following tasks:

» Activate the license server to make licenses available for check out.
» Inform users of the license server machine name and port number.

Connecting to a License Server

If your organization purchased concurrent licenses for Mapinfo Professional, you will need to
connect to a license server to run the product.

To connect to the license server, Maplnfo Professional must have the license server name and port
number. Your license server administrator will provide you with this information.

Connecting During Installation

The installation program will ask you for the license server name and port number. If you know them
at install time, enter them. When you start MapInfo Professional, you will be connected to the license
server and a license will be checked out automatically.

If you do not have this information at the time you install Mapinfo Professional, the installation
program will enable you to continue with the installation without filling in the license server name and
port number. You will have another opportunity to connect to the server when you start Maplinfo
Professional.
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Connecting after Installation

If you did not specify the license server name and port number during product installation, you will be
prompted for that information when you start Maplnfo Professional. You will also be prompted if
Maplnfo Professional cannot connect to a running license server using the server name and port
number you provided at install.

To connect to the license server after you install MapInfo Professional:
1. Start Maplinfo Professional. The Connect to License Server dialog box displays on the screen.

This copy of MapInfo Professional requires a license server to run, Enter the name and port
number of your license server below and click Connect,

Connect to License Server

Server name:

Part number:

MOTE: If vou are not ready to connect ko your license server click Courtesy
Period, The courtesy period allows you o use MapInfo Professional for 15
days before connecting to the license server,

If you have the license server name and port number, proceed with these instructions. If you do
not, see

2. Enter the license server name in the Server name box.
3. Enter the port number in the Port number box.

4. Click Connect. MaplInfo Professional takes a few moments to connect to the license server and
check out a license.

When the license is checked out, the Connect to License Server dialog box closes. You are finished.
Maplnfo Professional is licensed and ready to use. After you successfully connect to your license
server once, a license will be checked out automatically when you start MapInfo Professional.

Starting the Courtesy Period

If you do not have the license server name and port number, but you want to start using Mapinfo
Professional, you can start a 30-day courtesy period during which you can use Maplinfo Professional
without connecting to the license server.

To use the courtesy period to run Maplnfo Professional:

1. Open Maplnfo Professional. The Connect to License Server dialog box displays on the screen.
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2. Click Courtesy Period. A Mapinfo Activation message displays telling you that the courtesy
period started successfully.

3. Click OK. Maplnfo Professional is ready to use under the courtesy period.

You can connect to the license server and check out a license when you receive the license server
name and port number from your license server administrator.

Connection Failures
Failure to connect to the license server can occur for several reasons.

First, although you may know the license server name and port number, the license server
administrator may not have had an opportunity to install it yet. In this case, Mapinfo Professional
cannot find the license server you specified. To use Maplnfo Professional, you can start the courtesy
period, and then connect when you know that the license server has been installed and is running.

Failures can also occur if the license server has been moved to a different computer. In this case,
you were previously able to connect to the license server, but the license server was moved since
the last time you used Maplnfo Professional. Mapinfo Professional is looking for the license server in
its previous location. If Mapinfo Professional cannot connect to the license server at startup, the
Connect to License Server dialog will display on the screen. See

for information. See your license server administrator for the correct license server name.

Finally, if all licenses have been checked out, you will not be able to run Maplinfo Professional. You
are able to connect to the license server, but you cannot check out a license because they are all in
use. You will need to wait until a license becomes available before you can check out a license.

Borrowing a Concurrent License

Some concurrent licenses can be borrowed. Borrowed license enable you to use Maplinfo
Professional when your computer is not able to connect to your license server. For example, if you
have Maplnfo Professional installed on a laptop computer and you are going to be away from the
office, you can borrow a license to use Maplinfo Professional while you are away. Check with your
license server administrator to find out if your concurrent license includes borrowing.

When you borrow a license, be sure to specify a borrow period that gives you sufficient time to use
Maplnfo Professional before the license expires. If the license expires before you have an
opportunity to return it, the license is automatically returned to the license server. Maplnfo
Professional is unusable until you can connect to your network again and check out a license.

To borrow a license, the computer that you want to put the borrowed license on must have Mapinfo
Professional installed and be connected to the license server.

To borrow a license:
1. Open Maplnfo Professional.

2. Choose Help > Licensing > Borrow license. The Borrow Maplinfo Professional License dialog
box displays on the screen.

3. Specify the number of days that you want to borrow the license. You can specify from one to 365
days.
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4. Click Borrow License. After a few moments, Mapinfo Activation message displays on the
screen to tell you that the license was borrowed from the server successfully.

5. Click OK.

You can use Maplnfo Professional on this computer while not connected to your network for the
borrow period that you specified.

Returning a Borrowed License

To return a borrowed license, you must reconnect the computer that is using the borrowed license to
your network. If it is not connected, the Return borrowed license command will not be available.

To return a borrowed license:
1. Reconnect the computer to your network.

2. Open Maplnfo Professional. A dialog box displays to tell you on what date the borrowed license
is going to expire.

3. Click OK.

4. Choose Help > Licensing > Return borrowed license. The Return borrowed license to license
server dialog box displays on the screen.

5. This dialog box explains how a license is returned. Click OK.

6. A Maplnfo Activation message displays on the screen to tell you that the license has returned to
the license server.

7. Click OK.

Distributable Licenses

We have developed a licensing model that allows companies to "distribute" permanent licenses
using your Maplnfo License Server, which is available on the MapInfo Professional DVD. This model
was developed for customers who have limited access to email or to the Pitney Bowes Software Inc.
FNO server. Distributed licenses follow a similar activation procedure to other models that are
handled using your License Server. For instructions on installing the License Server, please see the
License Server User Guide.

You can also return a distributed license to your License Server if you need to transfer it to another
computer. For these instructions, see

Before you start the distributed activation process, make sure you have the following pieces of
information from your License Server system administrator:

* The correct serial number and activation code
* The License Server machine name
* The port number for the server

Then you can begin your distributed license installation and activation.
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Activating a Distributable License
To activate a distributed license:

1. Make sure your Maplnfo License Server is running. Check to see that the server is set up
properly and contains the appropriate activated licenses.

2. Begin the Mapinfo Professional installation process as you would with any other license model.

3. When you are prompted for your serial number and access code, enter the distributed license
serial number and activation code. Distributed license serial numbers begin with "MID". Click
Next. The License Server Name and Port dialog box displays.

5 Maplnfo Professional 10.5 - License Server Name and Port g]

Enter the name and port number of your license server below -.
A

‘four serial number indicates you have purchased MapInfo Professional 10,5 to be used
with a license server, Enter the network name and port number of your organization's
license server here, I you do not have this information, click Mext ko skip this step,

License Server Mame

|'|,'|,y0ur|icenseserver

License Server Pork Number

27000

< Back ” ek = ] [ Cancel

G) The port number defaults to 27000 but it can be set by your License Server system
administrator. Check with the administrator if the port number is not working.

4. Type in your License Server’s (machine) name in the first field and the port number in the second
or leave the default entry in place. Click Next to continue. The remaining installation prompts are
the same as in Installing Mapinfo Professional in the User Guide.

5. When you open Maplinfo Professional for the first time, one of the following occurs:

» If the application finds the license server, and the serial number, activation code, and port
numbers are correct, the application opens and the product is activated.

» If the application did not access the license server, did not recognize the serial number or
activation code, or did not recognize the port number, an error message displays. We
recommend that you review these components to ensure that they are correct and/or work
with your system administrator to review these four pieces of information. Correct the
erroneous information and begin the activation process again.

After you activate your license, you can review the licensing details in MapInfo Professional by
selecting Help > About this Mapinfo Product. The About this MapInfo Product dialog box displays:
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Thiz product is licensed to:

Uszer

Fitney Bowes Maplnfo Corporation

Serial Number : MIDWEL1050000000

Access Code : 000000

Distributed license from 27000&LICENSESERVERNAME

The serial number, access code, and licensing details display in this box for future
reference.

Transferring a Distributed License

You can transfer a distributed license to your License Server, when you want to move the license to
another computer.

G) Before making any hardware changes to your PC (such as disk re-formatting) please
remember to return your activated license back to Pithey Bowes Software Inc. or to your
License Server. After your hardware has been changed you may then re-activate your
license.

To transfer a distributed license to your License Server:

1. Choose Help > Licensing > Transfer License. The Return distributed license to license server
dialog box displays.

Return distributed license to license server g|

This operation will return your distributed license to the license server,
This action will remove the license from this computer and MapInfo Professional will close,

After you continue, you will be prompted to save all your work, if necessary.,

[ Ok H Cancel ]

2. Click OK to transfer the distributed license to the server. After the transfer is complete, a
confirmation message displays. You can then install MapInfo Professional again on another
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computer using the same serial number, activation code, license server name and path, and port
number.

If you have unsaved or open Maplinfo table data, the Save Modified Table Data dialog box
displays. This dialog box helps you save or discard data before you transfer your license to your
License Server. Click the appropriate option to save or discard this data:

» Click Save to save the open table data

« Click Save All to save the open data in the appropriate data tables

» Click Discard to close the open table without saving the modified data

» Click Discard All to close the open tables without saving the modified data

After you make your selection in this dialog box, the transfer continues as described above.

@ After you return the license, the application closes. Since MaplInfo Professional is still
installed on your computer, if you open the application again, the product will attempt to
activate another distributed license. If the license is not available, you can use the courtesy
license for the balance of your 30 day trial.
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Workgroup Installations

Maplnfo Professional is a desktop application that places user data on a map to
simplify business analysis for data with a spatial component. This section will
assist you in setting up a Maplnfo Professional network share workgroup that
allows users to share application data resources (such as coordinate system
information and templates). Sharing these resources can unify the look of user
maps and provide consistency in their data.

There are two steps to this Workgroup installation process:

1. System administrators create a shared location for the application
data files and create a method for users to install Maplnfo Professional
on their own computers.

Before you begin, see Understanding the Workgroup Installation

Process. To get started, see Beginning a Workgroup Installation
(System Administrators).

2. Users install the application on their computers, pointing to the shared
location for their Application Data Files.

To complete a workgroup installation, go to Completing a Workgroup
Installation (MapInfo Professional Users)

Topics in this Section:

¢ Understanding the Workgroup Installation Process. .......... 47
¢+ Beginning a Workgroup Installation (System Administrators) . .47

¢+ Completing a Workgroup Installation (MapInfo Professional
Users)50
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Understanding the Workgroup Installation Process

The workgroup installation process lets a system administrator store commonly used files in a
shared, central location to accommodate Vista requirements. This workgroup installation allows
users to retrieve the Application Data Files (such as the MAPINFOW.PRJ file and custom symbols)
from a shared, network location but install the program locally. Using this model, all users can share
coordinate system settings, templates, and custom symbols.

The workgroup install process is organized in to two steps, so that you can choose to have users:

» install Maplinfo Professional from a network location, or
» install Maplnfo Professional from a DVD you create for their use.

If copying the contents of the MaplInfo Professional DVD to another location, copy both the MI_PRO
and Pro_WG folders together to the same place. The workgroup install has a dependency to the
MI_Pro folder, so both folders must be located together under the same parent directory. If they are
not located together, then the Workgroup Installer installs only Application Data Files.

If you have any questions or difficulty with this process, please refer to the Mapinfo Professional
User Guide to determine the appropriate Pitney Bowes Software Inc. resource to call.

What are the Application Data Files?

Application Data Files are user files that affect the look and basic settings of your Maplnfo maps.
Specifically:

* Custom Symbols
» Graph Support
* Layout Templates
» Configuration files:
+  MAPINFOW.ABB (The abbreviations file)
*+  MAPINFOW.CLR (The colors file)
*  MAPINFOW.FNT (The fonts file)
*  MAPINFOW.MNU (The menu file)
*  MAPINFOW.PEN (The pen file)
*  MAPINFOW.PRJ (The projections file)
* Thematic Templates
*  WFS and WMS server lists

Beginning a Workgroup Installation (System Administrators)

To prepare for a Workgroup installation:

1. Inset the installation DVD, click Install Products > Mapinfo Professional > Maplinfo
Professional Workgroup. The Workgroup Install screen displays.

Vista & Windows 7 users: You may see a prompt for permission to continue. Click Allow or
Yes to proceed (if you do not respond and the message times-out, the install is unsuccessful).
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2. Click Install Mapinfo Workgroup. The Welcome screen displays.
3. Click Next. The License Agreement screen displays.

4. Click I agree and click Next. The Custom Setup dialog screen displays.

5 Workgroup Installer 10.5 - InstallShield Wizard &
Custom Setup

Select the program features you want installed. .

Click on an icon in the list below to change how a Feature is installed.

Feature Description

= ~ | Application Data Files i : S—
=~ F | v10.5 Installer ach user must use this installer

to run MapInfo Professional.
Each user should run this installer
locally.

This feature requires 486ME on
wour hard drive.,

Select a shared path accessible to all users:

C:\Program FilesiMapInfolWorkgroupiMapInfoProv105Installer!,
[ Help ] [ Space ] [ < Back ” Mext = ] [ Cancel ]

CD All Application Data Files are selected by default.

5. To prevent file sharing of one or more of these file types, click the drop-down arrow beside the
file type and select This feature will not be available from the list.

Custom

=- |

= This feature will be installed on local hard drive.

=28 This feature, and all subfeatures, will be installed on local hard drive,

@ When you choose not to install file(s) to the shared location, Maplnfo Professional uses
the local copy of these file(s) instead.

6. Highlight the Application Data Files entry and click Change. The Change Current Destination
Folder displays. Navigate to the shared location for storing these files and click OK.
Make sure that this shared location is accessible by all users who need these files. Users
will need read/write access to add new templates and other custom symbols to share.

CD When users install MapInfo Professional, these same Application Data Files are also
stored locally. This allows them to access these files when the shared folder is
unavailable. For more details, see Completing a Workgroup Installation (Maplnfo
Professional Users) on page 50.
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7. Highlight the Mapinfo Professional v10.5 Installer entry and click Change to display the
Change Current Destination Folder dialog box.

5 Workgroup Installer 10.5 - InstallShield Wizard

Custom Setup .
Select the program Features you want installed,

Click on an icon in the list below to change how a Feature is installed.

Feature Description

The Application Data Files are a
) set of configuration files, symbol
= - | Thematic Templates sets, and kemplates that

= Application Data Files
+- = = | Configuration Files

(=3 ~ | Custom Symbols enhance your user's MapInfo

= - | Graph Suppaort Professional maps.

=3 ~ | Layout Template This feature requires OKE on
= v| MapInfo Professional 10,5 Installer your hard drive. It has 5 of 5

subfeatures selected, The
subfeatures require 16ME on
wour hard drive.,

Select a shared path accessible to all users:

C:\Program FilesiMapInfolWorkgroupiApplicationDatay 1 05Y
[ Help ] [ Space ] [ < Back ” Mext = ] [ Cancel ]

Do one of the following:

» If you want your users to install Mapinfo Professional from a DVD you create:
select a local destination folder and click OK. This installer then copies the Mapinfo
Professional installation files to the local destination folder you selected. At the end of this
process, you can create installation DVDs for each user from the installation files copied to
this local folder. You can then distribute these DVDs to each user so they can begin their
Maplnfo Professional installation.

» If you want your users to install Mapinfo Professional from a central network location:
select a network location folder and click OK. This installer then copies the MaplInfo
Professional installation files to the network location folder you selected. At the end of this
process, notify each user of this network destination folder so they can begin their MaplInfo
Professional installation.

The Custom Setup dialog box displays.
8. Click Next to display the Ready to Install the program dialog box. Click Install.
9. Atthe end of this process, the Completed dialog box displays. Click Finish.

10. Finally, do one of the following:

» If you saved the installation files locally, create one Maplnfo Professional installation DVD for
each user from the contents of the local folder. Make sure you copy the mode.xml file along
with the other installation files in that directory.

» If you saved the installation files on the network, notify each user of that network location so
they can install Mapinfo Professional locally.
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During this process, you created a MODE.XML file that contains the shared location you set for the
Application Data Files. When the user opens Maplnfo Professional for the first time, the path to the
shared location is copied from the XML file to the user’s computer registry. If you need to change the
network location of these files, follow the instructions in

@ IMPORTANT: If your users ask you about the product serial numbers, you can find them on
the outside of the Maplnfo Professional box. Serial numbers are also in a letter inside the
box, if you need to store them.

The Application Data Files are also stored locally for use when the shared folder is unavailable. The
next section describes this in more detail.

Completing a Workgroup Installation (MaplInfo Professional
Users)

To complete the workgroup installation, do one of the following:

» If your system administrator has given you a DVD for installation, place this media in the
appropriate computer drive and follow the MapInfo Professional Installer instructions.

» If your system administrator has placed the MapInfo Professional installer in a network
location, navigate to that location and follow the MapInfo Professional Installer instructions.

Understanding your Workgroup Installation

When you install Maplnfo Professional as part of a workgroup, you share commonly used files with
the other users in your organization. Workgroups use the same configuration, template, and custom
symbol files without having to copy them manually. This method supports each workgroup member
in creating more consistent maps.

As part of your application’s installation process, the Maplnfo Professional installer creates a local
copy of these Application Data Files for your use when the shared location is not available. This is
very important.

» Ifthe shared location of your Application Data Files is available,
Maplnfo Professional saves your template, symbol, and configuration work to the shared
location.

» If the shared location of your Application Data Files is not available,
Maplnfo Professional saves your template, symbol, and configuration work to your local copy of
these files.

@ If the shared location is not available when you open Maplinfo Professional for the first time,
an error displays explaining that the application will use the local Application Data Files. You
can use the instructions in to select a
new shared location, if necessary.
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Since typically you will access the shared location, this will not be an issue. But if you change any of
the Application Data Files locally and the shared location becomes available, we recommend you
copy your work to the shared location. This will ensure that your files are available when you and
your co-workers need them.

A Note about Graph and Theme Template Files

The search for graph and theme template files is dependent upon the folder setting in the Directory
Preferences dialog box. If these preferences do not exist in the network location, the application
searches for files locally.

Changing the Shared Location after Installation

To change the shared location for these files after installation, use the Directory Preferences dialog
box. Each user in the Workgroup needs to follow this procedure to maintain these shared files.

To change the application data file location for a Workgroup user:

1. Choose Options > Preferences > Directories to display the Directory Preferences dialog box.

Directory Preferences g]
Initial Directories for File Dialogs
Tables CADOCUMENTS AND SETTINGS\MYNAME WY DOCU A
Remote Tables CADOCUMENTS AND SETTINGS\MYNAME MY DOCUb
Wworkspaces CADOCUMENTS AND SETTINGS\MYNAME MY DOCUR
MapBasic Programs ~ C:\PROGRAM FILES\MAPINFOLPROFESSIONALATOOL!
Import Files CADOCUMENTS AND SETTINGS\MYNAME MY DOCUb
SOL Queries CADOCUMENTS AND SETTINGS\MYNAME MY DOCUR
Theme Templates CADOCUMENTS AND SETTINGS \MYMNAME\APPLICATI
Saved Queries CADOCUMENTS AND SETTINGS\MYNAME MY DOCUb
Mew Grids CADOCUMENTS AND SETTINGS\MYNAME MY DOCUb

Crystal Report files CADOCUMENTS AND SETTINGSSMYMNAME MYy DOCUR
franh Sunnart Files  CADACTIMFHTS AMD SFTTINGS A | 1 ISFRSSAPPI M ™
£ >

‘workgroup Directary

Usze when searching for application data files [e.g. mapinfow. pri]

C:\PROGRAM FILES\MAPINFOY D

Search Directonies for Tables

[ QK ][ Cancel ][ Help ]

The shared location displays in the Workgroup Directory field.
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2. You can reset the Workgroup folder in one of these ways:

» To set a new shared location, enter a new path in the field provided or click D to select a
new shared path.
» To use local files only, clear the Use when searching for application data files check box.

@ You can use named drives or UNC paths in the Workgroup Directory field.

3. Click OK to confirm your change. The application saves this new path to your registry. Each time
you open Maplnfo Professional after this, the application uses this new path to access the
Application Data Files.
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This chapter helps a system administrator install MapInfo Professional using a
commandline.

Topics in this Section:
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Silent Installation Procedures for System Administrators

Silent installations allow you to repackage Maplinfo Professional for deployment within your
company so your users do not have to enter user- or company-specific information, path
information, a serial number, or an access code.

@ You may also be interested in reviewing the Mapinfo Professional Workgroup Guide for file
sharing to use this installation model for deploying MapInfo Professional.

The Maplnfo Professional installation setup.exe indicated in the steps below can be found on the
installation DVD (d:\) in this directory:

\Install\MI PRO\DISK1
In general, the silent installation process goes like this:
1. Place the installation DVD in the target computer’s disk drive.

2. From the command line on the target computer, type:
"[drive and path to setup exe]:setup.exe" /s /v"[Parameters for MSI]"
where PARAMETERS for MSI are the parameters you set to populate the msiexec .
For example:
"d:\Install\MI PRO\DISKl\setup.exe" /s /v"/gb
INSTALLDIR=\"[PathTo] \MapInfo\OtherThanStandard\Professional 10.5\"
USERNAME=\"MyUser\"
COMPANYNAME=\"MyCompanyName\"

PIDKEY=MySerialNumber
ACCD=MyAccessCode"

@ The command line parameters for the installer can not contain

The parameter /gb tells the msiexec command to launch the install with a basic interface. That does
not require any user action and allows the user to respond to the UAC in Vista.

There should be no space in between Variable=Content. A space is used as a separator in between
parameters.

Parameters for user information:

USERNAME=User Name
COMPANYNAME=Company Name

Parameters for installation target information:

INSTALLDIR=Install Directory

CRYSTALRINST=False (Use this parameter to decline the installation of Crystal Reports,
installed by default)
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Parameters for licensing information:

PIDKEY=Serial Number
ACCD=Access Code
LSNAME=License Server Name
LSPN=License Server Port Number

Parameters for activating node lock and distributed licenses silently:

ACTLIC=True - for silent automatic NODE LOCK and DISTRIBUTED activate licenses
RETLIC=True - for silent return licenses

LICLOG=Filename for log files

BORROW-=#days or True (If no specific number of days are entered, True is a valid input and
results in a # of days)

SDRLYN=False (Use this parameter to see no license transfer dialog when the user uninstalls.
The license stays on the system if not RETLIC=True).

CD Parameters ACTLIC and RETLIC are False by default.

For concurrent licenses the parameters for the license server name and license server port number
must also be included:

1. Place the installation DVD in the target computer’s disk drive.

2. From the command line on the target computer, type:
"d:\Install\MI PRO\DISKl\setup.exe" /s /v"PARAMETERS"
where PARAMETERS are the parameters you set to populate the msiexec.
For example:

"d:\Install\MI_ PRO\DISKl\setup.exe" /s /v"/gb
INSTALLDIR=\"[PathTo] \MapInfo\OtherThanStandard\Professional 10.5\""

CD All of the Microsoft supported parameters for working with the MSIEXEC command are
documented on the Microsoft web site. Search the term "MSIEXEC command line
parameters" to find this detailed information.

Look for the type of installation you want to perform from the options below and follow the
corresponding instructions. In each of the install scenarios described below, the serial number and
access code parameters are given in the following format:

o PIDKEY=MI#####4#4444444
o ACCD=##4##4#4#

Substitute the appropriate serial number and access code when you perform the silent install.
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Installing Silently on a Vista and Windows 7

You cannot perform a completely silent install of Maplnfo Professional on Windows Vista computers.
The command-line options /q and /gn do not work on Vista. These options turn off the user interface
during the installation, which suppresses the Windows Vista User Access Control (UAC). Users
must interact with the UAC to provide the necessary credentials to run the installation as an
administrator. If the user interface is turned off, the installation is terminated without warning
because the UAC cannot gather the appropriate credentials.

To work around the problem, use the /gb option in the command line when you run the silent install.
This option gives the installation a basic user interface and allows the UAC to display on the screen.

To perform a silent install on a Windows Vista computer using the /gb option:
1. Place the installation DVD in the target computer’s disk drive.

2. From the command line on the target computer, type:

"d:\Install\MI PRO\DISKl\setup.exe" /s /v"/gb USERNAME=\"MyUser\"
COMPANYNAME=\"MyCompanyName \"PIDKEY=MI#############F# ACCD=H##H#H#H##"
where:

PIDKEY=MI############## is the product serial number
ACCD=###### is the access code

3. When User Access Control displays on the screen, click Allow.
For concurrent licenses, the license server name and port number parameters must be included:

LSNAME="LicenseServerName"
LSPN="LicenseServerPortNumber"

Substitute the appropriate license server name and port number when you perform the silent install.

Activating and Returning Licenses Silently

Information Technology engineers may want to activate or return Maplinfo Professional node-locked
or distributed licenses silently, using a log file for reports. The return process described in this
section can also return a borrowed license to the server. This section describes these processes.

Activating a Node-Locked or Distributed License Silently

A node-locked license is a permanent license that originates from the Pitney Bowes Software Inc.
FNO server. A distributed license is a permanent license that originates from a License Server
owned by your company. This same process works for both types of license activations.

@ Before making any hardware changes to your PC (such as disk re-formatting) please
remember to transfer your activated license back to Pitney Bowes Software Inc. or to your
License Server. After your hardware has been changed you may then re-activate your
license.
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To activate a node-locked or distributed license silently:

1. Collect the information you need to install MaplInfo Professional on the client’'s computer,
including the appropriate serial number and access code. For distributed licenses, you also need
to enter your license server’s name and port number.

2. From the client computer’'s command line, type the following and press Enter:

<path to application>\MapInfow.exe -ActivateLicense c:\mylog.txt
where c:\mylog.txt is the path and name of a log file that tracks the details (successes and
errors) of the activation process. The log file is optional.

®

If you do not specify a log file, as in the example below, the application creates a file

called activatelicense.log in your temp folder.

<path to application>\MapInfow.exe -ActivateLicense

One of these events occurs:

» If the serial number begins with MID, the application attempts to activate a distributed license

» If the serial number begins with MIN,

license

the application attempts to activate a node-locked

* There was an error in the activation process that requires correcting

To view the results of the activation process after it is complete, open the log file with any text
editor. Possible log file messages include:

Message

What to Do

Your node lock license was activated
successfully.

The activation process is complete.

Your distributed license was activated
successfully.

The activation process is complete.

A license was already activated. No new
license is activated.

The activation process is complete.

One of the license components is incorrect
or missing

Check the log file to see which component (serial
number, activation code, or for distributed licenses,
server name or port number) is missing or incorrect.

No license was activated as your license
appears to be a concurrent or borrow type
license.

Check your License Server and to review the type(s)
of licenses that are available. Your client may need
to get a concurrent or borrow a license instead. See

for more details on these license types.
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Before making any hardware changes to your PC (such as disk re-formatting) please remember to
return your activated license back to Pitney Bowes Software Inc. or to your License Server. After
your hardware has been changed you may then re-activate your license.

You can return a node-locked, borrowed, or distributed license to the Pitney Bowes Software Inc.
FNO or your License Server using these instructions:

From the client computer’'s command line, type the following and press Enter:

MapInfow.exe -ReturnLicense c:\mylog.txt
where c:\mylog.txt is the path and name of a log file that tracks the details (successes and
errors) of the return process. The log file is optional.

®

If you do not specify a log file, as in the example below, the application creates a file

called returnlicense.log in your temp folder.

<path to application>\MapInfow.exe —-ReturnLicense

One of these things occurs:

* The license is returned to the Pitney Bowes Software Inc. FNO server or your License Server
* An error occurs preventing the return of the license

To view the results of the return process after it is complete, open the log file with any text editor.
Possible log file messages include:

Message

What to Do

Your distributed license was returned
successfully to the license server
<ServerName>.

The return process for the distributed license is
complete.

Your borrowed license was returned
successfully to the license server
<ServerName>.

The return process for the borrowed license is

complete.

Your node license was returned

successfully to Pitney Bowes Software Inc..

The return process for the node-locked license

is complete.

If returnable license was found but the
system could not return it, the system posts
an error message describing the error.

Check the log file for the details of the error and
correct the problem either on the client’s
machine or in your License Server, as needed.

No license was returned as no distributed
license was found.
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Message

What to Do

No license was returned as no server
license was found.

Check your License Server to make sure the
license is available and the server is up. Then
try the return process again.

No license was returned as no node- lock
license was found.

Check the About this Product dialog box to
ensure that the license is node locked and try
the return process again.

Uninstalling Silently

To perform a silent uninstall of MapInfo Professional 10.5:

* From the command line on the target computer type:
msiexec.exe /x {540083C1-03E8-4665-9566-DF5412F1000A}/q

Running this command only uninstalls MapInfo Professional 10.5. It does not uninstall a previous
version of Maplnfo Professional. It does not uninstall MapInfo ProViewer, MapInfo Runtime, or

MapBasic.

@ The uninstall key is unique to each version of Maplnfo Professional. To silently uninstall an
older version of Maplnfo Professional, you would need to use its product code (uninstall key).

These keys are in the regestry at

HKEY_LOCAL_MACHINE\SOF TWARE\Microsoft\Windows\CurrentVersion\Uninstall\
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Controlling Advanced System Settings

Maplnfo Professional has some advanced system settings that cannot be configured through a
dialog box. These settings allow you to control several low-level, technical aspects of how Maplnfo
Professional runs. Most users do not need to worry about these advanced settings.

For example, MaplInfo Professional has a Dynamic Data Exchange (DDE) time-out setting, which
controls how long Maplinfo Professional tries to communicate with other applications during DDE
communications. If you run a MapBasic application, and that application encounters time-out errors
during DDE, you may want to increase the DDE time-out setting. To modify one of MaplInfo
Professional’'s advanced system settings (such as the DDE time-out setting), use this procedure.

Modifying the Windows Registry

Maplnfo Professional stores system settings in the Windows registry. To edit the Windows XP
registry, use the REGEDT32 program.

CAUTION: Be very careful when editing the registry; damaging the registry can cause
serious problems in your operating system.

For example, to set Mapinfo Professional’s Dynamic Data Exchange (DDE) time-out setting, locate
the following key in the registry:

HKEY LOCAL MACHINE\SOFTWARE\MapInfo\MapInfo\Common

Within that key, edit the DDeTimeout value. If there is no value by that name, create a new value of
type string, and assign the name DDeTimeout to the value. Set the value’s data to be a number,
representing the number of milliseconds (for example, enter 30000 to specify a time-out of 30
seconds). For more on editing the registry, see the online help for REGEDIT or REGEDT32.

Descriptions of Advanced Registry Settings

This section describes advanced settings that are stored in the registry.

@ Set Polygon Mode or Subdivide Printing in Maplinfo Professional by selecting Options >
Preferences > Output Settings.

DDeTimeout = number

This setting controls Mapinfo Professional’s time-out setting in DDE conversations where Maplinfo
Professional is the client (the application that initiates a conversation). The number represents
milliseconds. The default value is 10,000 milliseconds (ten seconds). If you run a MapBasic
application that attempts to initiate a DDE conversation, but the conversation fails because the
server application does not respond within the time-out period, you may need to increase the
DDeTimeout number.

MaxFiles = number

This setting must be an integer from 10 to 507, indicating how many files Maplnfo Professional can
open simultaneously. This setting does not limit the number of tables you can open, but it does limit
the number of tables you can edit at one time (the number of tables that have unsaved edits). The
default value is 29. If you need to work with more files simultaneously, set number to 507.
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MaxORACLETILES = number

The number is 0 (zero) or 1 (one). This setting applies when working with Quad-Tree indexed Oracle
tables from versions of Oracle that are older than version 10. A value of 0 (zero) causes Maplnfo
Professional to disable spatial query and return all records using client-side clipping. A value of 1
(one) or more specifies the maximum number of tiles to use per geometry to refine a spatial query.
When creating a spatial index using the old Quad-Tree method, you specify the number of tiles to
use. This value lets you further refine the search by specifying the max number of tiles to use.

Improving Performance for Mapinfo Professional

To improve Maplinfo Professional’s performance, you can increase the speed of the processor in the
machine. A video accelerator card will increase the speed of the redraw. It will not speed up the
initial draw of the map, but all subsequent redraws will be faster. A faster disk cache will also
improve performance, as will adding memory.

Controlling the Location of Application Data Files

By default, the setup program for Maplnfo Professional installs application data files to locations that
make sense for the typical user. After installing the product, the user is free to move one or more of
the application data files to another predefined location and MaplInfo Professional will find that file.
For example, the administrator of a machine might move MAPINFOW.PEN from the per user area
(its default location) into the install directory so all users on that machine will share the same set of
pens. For IT personnel responsible for a large number of MapInfo Professional installs, it is not
practical to manually move application data files to realize the desired configuration.

To solve this problem, create a setting file, MODE.INI, to specify the location of application data files
prior to installing Maplnfo Professional.

1. Copy the installation files to a read-write location.

2. Create a MODE.INI file in the root directory of the installer.

Code Description Location

1 per user, roaming <Current User>\Application Data

2 per user, not roaming | <Current User>\Local Settings\Application Data
3 per machine <All Users>\Application Data

4 program directory <Install Dir>

1. Open MODE.INI into any text editor.

2. Edit MODE.INI, modifying the code associated with the application data file/folder whose
location you wish to change.

3. Install Maplinfo Professional.
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The following is a list of predefined locations for application data files supported by Maplinfo
Professional, and the corresponding numeric code to be used in MODE.INI.

The following is a list of application data files/groups and their default locations:

Filename Default Location
CustSymb per user, roaming
GraphSupport per machine
LayoutTemplate per user, roaming
MAPINFOW.ABB program directory
MAPINFOW.CLR per user, roaming
MAPINFOW.FNT per user, roaming
MAPINFOW.MNU program directory
MAPINFOW.PEN per user, roaming
MAPINFOW.PRJ program directory
ThmTmplt per user, roaming
WFSWMS . xml* per user, roaming

* The file called WFSWMS.XML is a representation of three separate files:

*  MICSWServers.xml — this file is related to the MetaData Catalog Browser tool

*  MIWFSServers.xml — this file is related to the list of WFS servers for File > Open Web Services >
WEFS feature

*  MIWMSServers.xml — this file is related to the list of WMS servers for File > Open Web Services
> WMS feature

MODE. INI File Example
Create a text file with the following syntax:

GraphSupport = 3
CustSymb = 1
ThmTmplt = 1
Layout Template = 1
MAPINFOW.CLR =
MAPINFOW.FEFNT =
MAPINFOW.PEN =
MAPINFOW.ABB =
MAPINFOW.PRJ =
MAPINFOW.MNU =
WESWMS . XML = 4

I A N i i

Maplinfo Professional 10.5 63 Install Guide



Troubleshooting Your
Installation

This section provides troubleshooting notes for installing Maplinfo Professional.

Topics in this Section:

¢+ Installationlssues ............ ... i i 65
¢ ErrorMessages . .......ouiiiiiiiiii i 65




Chapter 7: Troubleshooting Your Installation
Installation Issues

Installation Issues

The Microsoft ACE Engine does not install on Windows 7

The ACE engine, supplied with Maplinfo Professional 10.5, lets you open Excel 2007 and Access
2007 files when selecting File > Open in MaplInfo Professional. The Microsoft ACE Engine may not
install with MaplInfo Professional 10.5 on Windows 7, because the ACE engine is not supported on
Windows 7.

Opening an Excel 2007 or Access 2007 file in Maplnfo Professional on Windows 7 displays a
“Windows cannot open this file” message, and Maplinfo Professional may close unexpectedly.

To work around this issue, install Microsoft Office 2007 or go to the Microsoft web site to download
and install the Microsoft ACE Engine. You may do this either before or after installing Mapinfo
Professional 10.0 and 10.5.

Using .MSl file on the Installation DVD does not create a Warning
Message

If performing a silent installation of Maplnfo Professional, use the setup.exe file located in the
Instal\MI_PROD\DISK1 folder on the Mapinfo Professional DVD, and not the "MaplInfo Professional
10.0.msi" file. The .msi file does not install necessary prerequisites. Using the .msi file to install
Maplnfo Professional, instead of using setup.exe, causes MaplInfo Pro to install incorrectly.

Error Messages

Message: Unable to launch Mapinfo Professional

If the .NET install is canceled or interrupted when installing Maplnfo Professional, then after the
second attempt to install MapInfo Professional it does not launch and displays an "Unable to launch
Maplnfo Professional" message.

Maplnfo Professional requires .NET 3.5 Service Pack 1, so its install wizard installs .NET before it
installs Maplnfo Professional. If the .NET install is interrupted or canceled, then the MaplInfo
Professional install wizard cancels. When running the Maplnfo Professional install wizard a second
time, it assumes that .NET is installed on the machine (even though it did not install) and the
Maplnfo Professional software is unable to launch and run. The first attempt to install .NET leaves a
registry key set on the machine, so any subsequent installs do not attempt to install .NET again—the
Maplnfo Professional install wizard thinks that .NET is already installed.

To correct this issue, and install .NET to the machine, you must download the
from Microsoft’'s website and install it.
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Message: Either the Print Service is not running on your computer or
this setup can not determine the state...

If you see the following message, then the install was unable to upgrade the Maplnfo PDF Printer.

Either the Print Service is not running on your computer or this setup can not determine the
state of the Print Spooler service. In order to upgrade the Maplnfo PDF Printer, start the Print
Spooler service and then restart the installer.

The upgrade is unsuccessful when the Print Spooler is in a suspended state, such as stopped,
pending, or paused. Have your System Administrator start the Printer Spooler service on the
machine and then re-run the install to complete the upgrade.

Message: The feature you are trying to use is on a network resource that
is unavailable.
If you see the following message, then the install was run on Vista or Windows 7 without elevated
privileges.
The feature you are trying to use is on a network resource that is unavailable.
Re-run the install using elevated privileges, either:

* Right-click the executable file and select Run as Administrator from the popup menu to install
using elevated privileges. A prompt for permission to continue displays. Click Allow or Yes to
proceed (if you do not respond and the message times-out, then the install is unsuccessful).

* Have your System Administrator re-run the install, because your account does not have the
necessary privileges.
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